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Introduction

 A function is a predefined formula that performs

calculations using specific values in a particular order.

Excel includes many common functions that can be used

to quickly find the sum, average, count, maximum value,

and minimum value for a range of cells. In order to use

functions correctly, you'll need to understand the different

parts of a function and how to create arguments to

calculate values and cell references.
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The Parts of a Function

 In order to work correctly, a function must be written a specific

way, which is called the syntax. The basic syntax for a function is

the equals sign (=), the function name (SUM, for example), and

one or more arguments. Arguments contain the information you

want to calculate. The function in the example below would

add the values of the cell range A1:A20.
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Working with arguments

 Arguments can refer to both individual cells and cell ranges

and must be enclosed within parentheses. You can include one

argument or multiple arguments, depending on the syntax

required for the function.

 For example, the function =AVERAGE(B1:B9) would calculate

the average of the values in the cell range B1:B9. This function

contains only one argument.
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Working with arguments

 Multiple arguments must be separated by a comma. For

example, the function =SUM(A1:A3, C1:C2, E1) will add the

values of all of the cells in the three arguments.
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Creating a Function

 There are a variety of functions available in Excel. Here are

some of the most common functions you'll use:

❖ SUM: This function adds all of the values of the cells in the

argument.

❖ AVERAGE: This function determines the average of the values

included in the argument. It calculates the sum of the cells and

then divides that value by the number of cells in the argument.

❖ COUNT: This function counts the number of cells with numerical

data in the argument. This function is useful for quickly counting

items in a cell range.

❖ MAX: This function determines the highest cell value included in

the argument.

❖ MIN: This function determines the lowest cell value included in

the argument.
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Creating a function using the AutoSum command

 The AutoSum command allows you to automatically
insert the most common functions into your formula,

including SUM, AVERAGE, COUNT, MIN, and MAX. In

the example below, we'll use the SUM function to

calculate the total cost for a list of recently ordered
items.
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Creating a function using the AutoSum command

1. Select the cell that will contain the function. In our

example, we'll select cell D13.
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Creating a function using the AutoSum command

2. In the Editing group on the Home tab, click the arrow next

to the AutoSum command. Next, choose the desired

function from the drop-down menu. In our example, we'll

select Sum.
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Creating a function using the AutoSum command

3. Excel will place the function in the cell and automatically select

a cell range for the argument. In our example,

cells D3:D12 were selected automatically; their values will

be added to calculate the total cost. If Excel selects the wrong

cell range, you can manually enter the desired cells into the

argument.
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Creating a function using the AutoSum command

4. Press Enter on your keyboard. The function will

be calculated, and the result will appear in the cell. In our

example, the sum of D3:D12 is $765.29.
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Creating a function using the AutoSum command

 The AutoSum command can also be accessed from

the Formulas tab on the Ribbon.
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Entering a function manually

 If you already know the function name, you can

easily type it yourself. In the example below (a tally of

cookie sales), we'll use the AVERAGE function to

calculate the average number of units sold by each
troop.
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Entering a function manually

1. Select the cell that will contain the function. In our

example, we'll select cell C10.
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Entering a function manually

2. Type the equals sign (=), and enter the desired function

name. You can also select the desired function from the

list of suggested functions that appears below the cell as

you type. In our example, we'll type =AVERAGE.
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Entering a function manually

3. Enter the cell range for the argument inside parentheses.

In our example, we'll type (C3:C9). This formula will add

the values of cells C3:C9, then divide that value by the

total number of values in the range.
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Entering a function manually

4. Press Enter on your keyboard. The function will be

calculated, and the result will appear in the cell. In our

example, the average number of units sold by each

troop is 849.
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Warning

 Excel will not always tell you if your formula contains
an error, so it's up to you to check all of your formulas.
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The Function Library

 While there are hundreds of functions in Excel, the ones

you'll use the most will depend on the type of data your

workbooks contain. There's no need to learn every single

function, but exploring some of the different types of

functions will help you as you create new projects. You

can even use the Function Library on the Formulas tab to

browse functions by category, such

as Financial, Logical, Text, and Date & Time.

 To access the Function Library, select the Formulas tab on

the Ribbon. Look for the Function Library group.
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The Function Library

 Insert Function : If you're having trouble finding the right
function, the Insert Function command allows you to search for
functions using keywords.

 AutoSum Command : The AutoSum command allows you to
automatically return results for common functions, like SUM,
AVERAGE, and COUNT.

 Recently Used : The Recently Used command gives you access
to functions you've recently worked with.

 Financial : The Financial category contains functions for
financial calculations like determining a payment (PMT) or
interest rate for a loan (RATE).
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The Function Library

 Logical : Functions in the Logical category check
arguments for a value or condition. For example, if an
order is more than $50, add $4.99 for shipping; if it is more
than $100, do not charge for shipping (IF).

 Text : The Text category contains functions that work with
the text in arguments to perform tasks, such as converting
text to lowercase (LOWER) or replacing text (REPLACE).

 Date & Time : The Date & Time category contains functions
for working with dates and time and will return results like
the current date and time (NOW) or the seconds
(SECOND).
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The Function Library

 Lookup & Reference : The Lookup & Reference category
contains functions that will return results for finding and
referencing information. For example, you can add a hyperlink
to a cell (HYPERLINK) or return the value of a particular row and
column intersection (INDEX).

 Math & Trig : The Math & Trig category includes functions for
numerical arguments. For example, you can round values
(ROUND), find the value of Pi (PI), multiply (PRODUCT), and
subtotal (SUBTOTAL).

 More Functions : More Functions contains additional functions
under categories for Statistical, Engineering, Cube, Information,
and Compatibility.
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To insert a function from the Function Library

 In the example below, we'll use the COUNTA function to count

the total number of items in the Items column. Unlike

COUNT, COUNTA can be used to tally cells that contain data of

any kind, not just numerical data.
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1. Select the cell that will

contain the function. In

our example, we'll select

cell B17.



To insert a function from the Function Library

2. Click the Formulas tab on the Ribbon to access the Function

Library.

3. From the Function Library group, select the desired function

category. In our example, we'll choose More Functions, then

hover the mouse over Statistical.
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To insert a function from the Function Library

4. Select the desired function from the drop-down menu. In our

example, we'll select the COUNTA function, which will count

the number of cells in the Items column that are not empty.
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To insert a function from the Function Library

5. The Function Arguments dialog box will appear. Select

the Value1 field, then enter or select the desired cells. In our

example, we'll enter the cell range A3:A12. You may continue

to add arguments in the Value2 field, but in this case we only

want to count the number of cells in the cell range A3:A12.

6. When you're satisfied, click OK.
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To insert a function from the Function Library

7. The function will be calculated, and the result will appear in the

cell. In our example, the result shows that a total of 10

items were ordered.
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The Insert Function command

 While the Function Library is a great place to browse for

functions, sometimes you may prefer to search for one instead.

You can do so using the Insert Function command. It may take

some trial and error depending on the type of function you're

looking for; however, with practice, the Insert Function

command can be a powerful way to find a function quickly.
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Using the Insert Function command:

 In the example below, we want to find a function that will

calculate the number of business days it took to receive items

after they were ordered. We'll use the dates in

columns E and F to calculate the delivery time in column G.

1. Select the cell that will contain the function. In our example,

we'll select cell G3.
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Using the Insert Function command:

2. Click the Formulas tab on the Ribbon, then click the Insert

Function command.
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Using the Insert Function command:

3. The Insert Function dialog box will appear.

4. Type a few keywords describing the calculation you want the

function to perform, then click Go. In our example, we'll type

count days, but you can also search by selecting a category

from the drop-down list.
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Using the Insert Function command:

5. Review the results to find the desired function, then click OK. In

our example, we'll choose NETWORKDAYS, which will count the

number of business days between the ordered date and

received date.
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Using the Insert Function command:

6. The Function Arguments dialog box will appear. From here,

you'll be able to enter or select the cells that will make up the

arguments in the function. In our example, we'll enter E3 in

the Start_date field and F3 in the End_date field.

7. When you're satisfied, click OK.
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Using the Insert Function command:

8. The function will be calculated, and the result will appear in the

cell. In our example, the result shows that it took four business

days to receive the order.
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Using the Insert Function command:

 Like formulas, functions can be copied to adjacent cells. Simply

select the cell that contains the function, then click and drag

the fill handle over the cells you want to fill. The function will be

copied, and values for those cells will be calculated relative to

their rows or columns.
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Proper Function

 When you think about Excel functions, you probably think

about performing calculations with numbers. While it's true

that you can use functions to do lots of handy things with

numbers in Excel, some functions can help you format text

too.

 One good example is the PROPER function, which

capitalizes the first letter of every word in a cell. If you have
cells containing proper nouns, like names or titles, you can

use the PROPER function to make sure everything is

capitalized correctly.
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Proper Function

 In the following worksheet, you can see

that not everyone has been careful to

capitalize the first and last names of the

people they want to nominate, so the

spreadsheet looks messy. You could go

through the column and correct the

names manually, but using the PROPER

function will be faster and easier.
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Proper Function

 In this example, the

names of the nominees

are in column A, so we'll

put our formula in column

B. In cell B2, we'll type a

formula that tells Excel to

capitalize the name in

cell A2, which contains

the first name on our list.

The formula will look like

this:

=PROPER(A2)
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Proper Function

 Great! Now all the names of the award nominees are correctly

capitalized in the spreadsheet. There's one problem, though: We

still have the original uncapitalized names in column A. We can't

delete column A because our formula in column B refers to it.

Instead, we can copy the values from column B into a new

column by using the Paste Values feature in Excel.

 To do this, select cells B2:B14 and click the Copy command (or

press Ctrl+C on your keyboard). Then right-click the cell where

you want to paste the values (C2, for example), then select

the Values button from the menu that appears. If you're using

Google Sheets, you can right-click and go to Paste special >

Paste values only.

42



Proper Function

 Now we have a column that displays the corrected

names but that doesn't depend on a formula or cell

reference. This means we can delete our original columns

(column A and column B).
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Concatenate Function

 CONCATENATE lets you combine two or more things in one

cell—and despite the long name, it's actually easy to use.

 Let's say we have a spreadsheet of contact information

with last names and first names in separate columns, and

we'd like to combine them to get each person's full name.

In the image below, you can see that the first names are

in column B and the last names are in column A. Our

formula will go in cell E2.
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Concatenate Function

 CONCATENATE will combine exactly what you tell it to
combine, and nothing more. If you want punctuation,

spaces, or any other details to appear in the cell, you'll

need to tell CONCATENATE to include it. In this case, we

want the names to have a space in between them (so it

doesn't say JosephineCarter), so we'll need to add an

argument that contains a space. This means we'll need

three arguments:

B2 (first name)

" " (a space in quotation marks)

A2 (last name)

 Now that we have our arguments, we can type the

following formula into cell E2:

=CONCATENATE(B2, " ", A2)
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Concatenate Function

 That's it! When you press Enter, it should display the full

name: Josephine Carter.

 Now you can click and drag the fill handle down through

cell E11, and it should display the full name for each
person.
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Concatenate Function

 Now, try using CONCATENATE to combine the city and

state in column F so it looks like the image below.

=CONCATENATE(C2, ", ", D2)
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Concatenate Function

 You can even use CONCATENATE to combine numbers

and text. For example, let's say we're using Excel to keep

track of a store's inventory. We currently have 25 apples in

stock, but 25 and apples are in separate cells. We want to

combine them into one cell so that it looks like this:
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Concatenate Function

 To do this, we'll need to combine three things:

F17 (number in stock)

" " (space)

F16 (product name)

 Type the following formula into cell E19:

=CONCATENATE(F17, “ ”, F16)

 Let's say we want it to say We have 25 apples. We'll just 

need to add an argument at the beginning that says We 

have:

=CONCATENATE(“We have ”, F17, “ ”, F16)
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IF function : Donation

 There are several different columns, and each row

contains the contact information for one person, along

with the amount of money that person donated.
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IF function : Donation

 So if a person donated at least $50, we need to write the

words Free Gift in that donor's row. We could go through each

row, look at the value, and then write Free Gift if the value is at

least $50. But there are a lot of people on the spreadsheet, so it

could be really time consuming to do this manually. What we

really need is way to make our spreadsheet do this

automatically.

 The IF function can simplify these kinds of problems. The IF

function can look at a value in a cell to see if it meets a basic

condition (in our example, if the value is greater than or equal to

50). Then it can then add text to an empty cell. Here, we can

use the IF function to look at each person's donation, then add

the words Free Gift if they donated at least $50. Basically, the IF

function can do the same thing we were planning to do, only it

can do it much faster.
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IF function : Donation56

=IF(G2>=50, "Free Gift", "")

Any formula

starts with an

equals

sign (=)

The first 

argument sets up 

the condition we 

want to test. For 

this formula, we 

want to know if 

the value in cell 

G2 is greater 

than or equal to 

50.

The next 

argument will tell 

the function what 

to write if the 

condition 

is true (that is, if 

the value is 

greater than or 

equal to 50).

The final argument will 

tell the function what to 

write if the condition 

is false. We could make 

the function write 

something like None

or No, but in this case 

we actually just want 

the cell to remain

blank. To do this, we'll 

just type double 

quotes ("") with no 

text inside.



IF function : Donation

 OK, you're done! When you press Enter, the words Free Gift

should appear in the cell.
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IF function : Donation

 Now we can just drag the fill handle down to add the

formula to the other cells in column H:
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IF function : Invoice

 You probably know that we currently charge $5.99 for

shipping on all of our orders. Well, we're going to start

offering free shipping if the subtotal of an order is at least

$100.
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IF function : Invoice60

=IF(D6>=100, 0 , $G$3)

Any formula

starts with an

equals

sign (=)

The first 

argument sets up 

the condition we 

want to test. For 

this formula, we 

want to know if 

the value in cell 

D6 is greater 

than or equal to 

100.

The next 

argument will tell 

the function what 

to write if the 

condition is true. 

In this example, if 

the value is 

greater than or 

equal to 100, we 

want it to write 

"0" in the cell.

The final argument will 

tell the function what to 

write if the condition 

is false. In this example, 

if the value is less than 

100, we want it to use 

the value from cell G3 

(5.99). So our third 

argument will be $G$3 

(we'll use an absolute 

reference here just in 

case we move this 

formula in the future).



IF function : Invoice

 If you entered the function correctly, the shipping cost should

change from $5.99 to $0.00. That's because the Order Subtotal is

more than $100.

 If you want to test the function, change the value in

cell C2 from 2 to 1. Because the Order Subtotal is now less than

$100, the Shipping cost should change from $0.00 to $5.99.
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IF function : Invoice

 Let's say we want to change the shipping cost to $6.99.

Select the cell we'd need to edit.
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CountA Function

 COUNTA simply looks at a range of cells and tells you how many

of the cells contain data. In other words, it looks for nonblank

cells. This can be useful in a variety of situations.

 In our example, we're using Excel to plan an event. We've sent

out invitations to everyone, and once we receive their

responses, we'll type either Yes or No in column C. As you can

see, column C still has some empty cells because we haven't

heard back from everyone.
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CountA Function

 Our responses are in cells C2:C86, but we can actually include a

few extra rows in case we decide to invite more people:

=COUNTA(C2:C100)

 When you press Enter, you'll see that we've received 55

responses. Here's the best part: We can continue to update this

spreadsheet as we receive responses, and our function

will automatically recalculate to give us the correct answer. Try

entering Yes or No into some of the empty cells in column C,

and you should see the value in cell F2 change.

68



CountA Function

 We can also use COUNTA to calculate the total number of

people that were invited. In cell F3, type the following function

and press Enter:

=COUNTA(A2:A100)

 All we had to do was type a different range (A2:A100), and it

counts all of the first names, giving us an answer of 85. If you

type more names at the bottom of the spreadsheet, Excel will

automatically recalculate this value. However, if you type

anything below row 100, you'll need to update your ranges so

any new people are included.

69



CountA Function

 We now have the number of responses in cell F2 and the

total number of invitees in cell F3. It would be great to

calculate the percentage of people who have

responded. See if you can write a formula in cell F4 that

calculates the percentage. (Show only one decimal by

using decrease decimal.)

=(100*F2)/F3
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VLOOKUP function : Invoice

 Our coworker asked if we could use the Product ID number to

find the product name and price from the Products worksheet.

Luckily, the VLOOKUP function can do this automatically.

 Before we write our function, we'll need to take a moment to

think carefully about the arguments will tell VLOOKUP what to

search for and where to look.
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VLOOKUP function : Invoice74

=VLOOKUP(A2 , Products!$A$2:$B$16 , 2 , FALSE)

The first 

argument tells 

VLOOKUP what 

to search for. 

In our example, 

we're searching 

for the product 

ID number, 

which is in 

cell A2.

The second 

argument is a cell 

range that tells 

VLOOKUP where 

to look for the 

value from our first 

argument. 

In our example, we 

want it to search for 

this value in cell 

range A2:C13 on 

the Products works

heet, so our second 

argument is

Products!$A$2:$C

$13.

The third argument is 

the column index 

number. The first 

column in the cell range 

from the previous 

argument is 1, the 

second column is 2, and 

so on. 

In our example, we're 

looking for the Product

Name. The names are 

stored in the second

column of the cell range 

from the previous 

argument, so our third 

argument is 2.

The fourth argument

tells VLOOKUP if it 

should look for 

approximate or exact 

matches. 

If it is TRUE, it will look 

for approximate

matches.

If it is FALSE, it will look 

for exact matches. 

In this example, we're 

only looking for exact

matches, so our fourth 

argument is FALSE.



VLOOKUP function : Invoice

 Before we start using

VLOOKUP, it will be helpful

to know what it does.

 In our example, it will search

for the Product ID number

on the Products worksheet.

It first searches vertically

down the first column

(VLOOKUP is short for

"vertical lookup").

 When it finds the desired

product ID, it moves to the

right to find the product

name and product price.
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VLOOKUP function : Invoice

 Now that we have our arguments, we'll write our function

in cell B2.

 If you entered the function correctly, the product name

should appear: Measuring cups. If you want to test your
function, change the Product ID number in cell A2

from MEA7879 to CHE7888. The product name should

change from Measuring cups to Cheesecloth.

76



VLOOKUP function : Invoice

 Next, we also want the Product ID to pull in the product price, so

we'll use the VLOOKUP function again. Since we're using the

same data, this function will be very similar to the one we just

added. In fact, all we have to do is change the third

argument to 3. This will tell VLOOKUP to pull in the data from the

third column, where the product price is stored:

=VLOOKUP(A2, Products!$A$2:$C$13, 3, FALSE)

 OK, let's enter our new formula in cell C3:
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VLOOKUP function : Invoice

 We've got our formulas working, so we can just select cells B2

and C2 and then drag the fill handle down to copy the formulas

to the other rows in the invoice. Now, each row is using

VLOOKUP to find the Product Name and Product Price.
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VLOOKUP function : Pets

 Let's say a veterinarian's office is creating a spreadsheet to

look up patient information. Here's the patient directory.

This is where information will be pulled from:
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VLOOKUP function : Pets

 Here's the patient lookup sheet. This is where the function

will be inserted.
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VLOOKUP function : Pets81

=VLOOKUP($B$1, Directory!$A$2:$F$14, 2, FALSE)Pet Name

=VLOOKUP($B$1, Directory!$A$2:$F$14, 5, FALSE)Phone




